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Engineering Data Information System 
(EDIS) Data Submittal Preparation 



These procedures are intended to help users in preparing files for submittal to 
EDIS.  Files may be submitted on DVD, CD-ROM or using the AMCOM 
Electronic Transfer (ET) Server.  Instructions for obtaining access to and using 
ET can be found in the EDIS Submittals Using the AMCOM Electronic Transfer 
Server document.  Customers uploading files to the upload server need to 
upload the files using the Data File Index Structure (DFIS) structure in .DLF 
format. 

 
Software to aid in creating the metadata file (index.dlf), IndexR, is available from 
the G6 Service Desk Home Page, https://g6msd.redstone.army.mil Enter the 
site and click on the DOWNLOADS tab. 

 
Call the G6 Service Desk, 256-955-0196, DSN 645-0196, or email 
usarmy.redstone.amcom.mbx.g6-edms-tag@mail.mil for assistance. 

https://g6msd.redstone.army.mil/
mailto:usarmy.redstone.amcom.mbx.g6-edms-tag@mail.mil


The first step is to create a .DH (Data Header) file using IndexR. 
 
1.  Start IndexR. 
2.  Go to Tools > Create DH. 

 

 
 
 
 
3.  Click on the Defaults button to load the default .dh file. 

 

 



4.  The Default .dh file will load with the default information on it. 
 

 



5.  In this screen you will input the Document Number, CAGE, Doc Type, Dwg 
Rev, Dwg Size, File Type, etc.  As a minimum all mandatory fields must be 
populated.  See Appendix A for a description of mandatory .dlf file entries.  All 
fields must be in the formats specified in MIS-STD-52406B-IS. 

 

 



 

6.  Go to Page 2. Click on the button to look for the image file that goes with 
the .dh file you are creating. 

7.  Browse your PC for the image file, then double-click on it.  This will populate 
the File Path, File Name and File Extension fields. 

 

 
 

 
8.  Click on the Save button. 



9.  Browse to the folder you want to save the file in.  Select the folder and click 
the OK button. 

 

 
 
 
 
10. To continue creating .dh files, go back to Page 1, change the index 

information for the next image and repeat Steps 6 thru 9. 
11. Once all of the .dh files have been created and saved, click on the Close 

button. 



12.  Create the .dlf file by clicking File > Open > DHs.  
 

 
 
13. Select the directory where you saved the .dh files and images.  Click the OK 

button. 
 

 



14. Click on the File > Save.  
 

 
 
15. Browse to the folder you want to save the index.dlf file. 
16. Enter index.dlf in the File name: box. 
17. Click the Save button. 

 

 



 

18. IndexR will ask you some questions about modifying the image file drive 
specification.  Click the Relative button. 

19. Click the OK button. 
 

 
 

 
20. Close IndexR. 
21. At this point, you are done creating the index.dlf file. 
22. Finalize the submittal and submit as specified in MIS-STD-52406B-IS. 

 
Call the G6 Service Desk, 256-955-0196, DSN 645-0196, or email 
usarmy.redstone.amcom.mbx-g6-edms-tag@mail.mil for assistance. 

mailto:usarmy.redstone.amcom.mbx-g6-edms-tag@mail.mil
mailto:usarmy.redstone.amcom.mbx-g6-edms-tag@mail.mil


 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

APPENDIX A 



 

METADATA DESCRIPTION 
 

Field 
Number 

MIS-STD-52406 
Mandatory 

Data Element  
FIELD DESCRIPTION 

Max 
Characters 

Notes 

1 X BaseDocNumber Document Number. 
Unique identifier for a drawing or other document as 
assigned by the organization identified by the 
document CAGE. 
Document numbers shall reflect what is in drawing 
title block and shall not include letters that would be 
on preprinted forms. 
If record describes an Accompanying Document, this 
field shall contain the Base Document’s Document 
Number. 

32 16 

2 X BaseDocCage Commercial And Government Entity (CAGE) 
Code. 
If record describes an Accompanying Document, this 
field shall contain the Base Document’s CAGE 
Code. 

5  

3 X BaseDocType Document Type. 
The value of the Base Document Type shall be a 
value from Appendix A, Document Type Listings 
(DTL). 
If record describes an Accompanying Document, this 
field shall contain the Base Document’s Document 
Type. 
If document does not have a document type, leave 
blank or null. 

2 4 

4 X DocumentSize Document Size. 
Value shall be one of the following: A, B, C, D, E, F, 
G, H, J, and K as defined by ASME-Y-14.1 

2  

5 X BaseDocRevision Document Revision. 
If record describes an Accompanying Document, this 
field shall contain the Base Document’s Revision. 
The following Document Revisions are invalid: I, 
O, Q, S, X, and Z. 
Single digit number revisions shall be zero padded to 
2 characters (i.e. 02). 
A blank, null, or dash ‘-’ is used to reflect no 
revision. 

2 4, 6, 
11, 13 

6  DocumentRevDate Revision Date. 
Date of Document Revision. Use dates of the form 
DD-MON-YYYY, where DD is the day of the 
month, MON is the alpha three-digit Month, YYYY 
is the four-digit year (i.e. 01-AUG-1959). 

20 7,12 

7  DocumentTitle Document Title. 
Human-readable short description of the document 

40 17 

8 X SheetNumber Sheet Number. 
The value shall be numeric, zero padded to 4 
characters. 

12 18 

9 X NumberOfSheets Number of Sheets. 
The value shall be numeric, zero padded to 4 
characters. 

4  

10 X BaseDocSheetRevision Sheet Revision. 
If record describes an Accompanying Document, this 

1 4, 11 



 

 

   field shall contain the Base Document’s Document 
Revision. 
The following Document Revisions are invalid: I, O, 
Q, S, X, and Z. 
Single digit number revisions shall be zero padded to 
2 characters (i.e. 02). 
A blank, null, or dash ‘-’ is used to reflect no 
revision. 

  

11 X FrameNumber Frame Number. 
If Document has no frames enter “0001”. 

4  

12 X NumberOfFrames Number of Frames. 
Total number of frames a sheet is composed of. 
If Document has no frames, enter “0001”. 

4  

13 X FileType File Type. 
Use appropriate value from Appendix C, Image File 
Types. 

5  

14  FileTypeFormat File Type Format. 
Use appropriate value from Appendix C, Image File 
Types. 

20 3, 10 

15  FileTypeSrcFlavor Source Flavor. 
Use appropriate value from Appendix C, Image File 
Types. 

20 3, 10 

16  FileTypeDestFlavor Destination Flavor. 
Use appropriate value from Appendix C, Image File 
Types. 

20 3, 10 

17  FileTypeContent File Type Content. 
Use appropriate value from Appendix C, Image File 
Types. 

20 3, 10 

18  FileTypeVersion File Type Version. 
Use appropriate value from Appendix C, Image File 
Types. 

14 3, 10 

19  SourceCage Site Code. 
CAGE code of the Data Originator. 

5 3 

20 X FileName File Name. 
Name of the Image file (without extension) 
corresponding to this record. If the 
Pathname\Filename in the delivery package for this 
record is “IMAGES\000\123456.XYZ”, “123456” 
would be the value in this field. 

32 8 

21 X FileExtension File Extension. 
Extension of the Image file corresponding to this 
record. If the Pathname\Filename in the delivery 
package for this record is 
“IMAGES\000\123456.XYZ”, “XYZ” would be the 
value in this field. 

3 8 

22 X FilePath File Path. 
Path to the Image file corresponding to this record. 
If the Pathname\Filename in the delivery package for 
this record is “IMAGES\000\123456.XYZ”, 
“IMAGES\000” would be the value in this field. 
File Paths shall be formatted IAW the description 
provided in Metadata Notes 8 and 9. . 

242 8, 9 

23 X MediaVolumeID Media Volume ID. 11 8 



 

 

   Volume ID of the media containing the Data 
Delivery. This field is only a required field if the 
delivery is a multi-volume physical media delivery. 
Each volume of a multi-volume delivery shall have a 
unique Volume ID name. 

  

24  MajorGroup Major Group. 
Major grouping designation within index. 
This field is generally left blank or null on a delivery. 

20  

25  MinorGroup Minor Group. 
Minor grouping designation within index. 
This field is generally left blank or null on a delivery. 

8  

26 X SecurityLevel Security Level. 
Security level assigned to sheet/image 
Value shall be one of the following: N, C, E, H, M, 
S, F, J, T, G, K. 
N Unclassified 
C Confidential 
E Confidential - restricted 
H Confidential - formerly restricted 
M Confidential - modified handling authorized 
S Secret 
F Secret - restricted 
J Secret - formerly restricted 
T Top secret 
G Top secret - restricted 
K Top secret - formerly restricted 
Data Delivery is required to be a Delivery 
Composition of Compact Disk (CD) Physical Media 
if this field is other than “N”. 

1  

27 X Rights Rights. 
Value shall be one of the following: U, G or L 
U Unlimited Rights 
G Government Purpose Rights 
L Limited, Restricted or Special License Rights 

1  

28 X ForeignSecure Foreign Secure. 
Foreign Secure designation. 
Value shall be one of the following: Y or N 
Y Foreign Secure 
N Not Foreign Secure 

1  

29 X Nuclear Nuclear. 
Nuclear equipment designation. 
Value shall be one of the following: Y or N 
Y Nuclear 
N Not Nuclear 

1  

30 X Subsafe Sub Safe. 
Sub Safe designation. Only for submarines, does not 
apply for Flight Critical. Indicates if drawing depicts 
critical safety info. 
SUBSAFE is a Navy program that requires special 
work procedures and inspections of equipment that 
cross the boundary of a submarine pressure hull. 
Examples include hatches, sensors and radio antenna 
wiring, and periscopes. The idea is to guarantee that 

1  



 

 

   seawater stays outside the pressure hull. 
Drawings which depict such equipment are labeled 
SUBSAFE so that ship crew and maintenance 
workers know they must apply the special 
procedures and inspections. 
Value shall be one of the following: Y or N 
Y Subsafe 
N Not Subsafe 

  

31  AirType Air Type. 
Leave Blank or null. 

6  

32  Apl APL. 
Leave Blank or null. 

35  

33  CadInfo Computer Aided Design Reference. 
Leave Blank or null. 

2  

34 X ControlCode Control activity code. 
This code identifies the primary repository that 
controls the official record copy of engineering data. 
Value shall be: BD 

2  

35  Hsc HSC. 
Leave Blank or null. 

12  

36  Nsn National Stock Number (NSN). 
NSN identifies an item of supply in the Federal 
Supply Catalog, maintained by the Defense Logistics 
Information Service (DLIS). 
Leave Blank or null. 

13  

37  Uic UIC. 
Leave Blank or null. 

5  

38  System System. 
Leave Blank or null. 

32  

39  Nomenclature Nomenclature. 
Leave Blank or null. 

20  

40  ShipClass Ship Class. 
Leave Blank or null. 

4  

41  ShipTypeHullNum Ship Type Hull Number. 
Leave Blank or null. 

9  

42  MasterLocation Engineering drawing master location. 
Leave Blank or null. 

30  

43  OfflineLocation Engineering drawing off-line location. 
Leave Blank or null. 

80  

44  ParentCage Parent CAGE. 
Leave Blank or null. 

5 19 

45  ParentDocNumber Parent Doc Number. 
Leave Blank or null. 

32 19 

46  PartNumber Part Number. 
Leave Blank or null. 

32  

47  SubSheet Sub Sheet. 
Leave Blank or null. 

3 15 



 

 

48  Succeeding Succeeding Drawing. 
Drawing number and CAGE of superseding drawing. 
Leave Blank or null. 

20  

49 X DistStmt Distribution Statement. 
Populated according to DODD 5230.24. 

2  

50 X AccDocType Accompanying Document Type. 
If record describes an Accompanying Document, this 
field shall contain the Accompanying Document’s 
Document Type as defined within Appendix B, 
Accompany Document Type Listing (ADTL). 
If record describes a Base Document, this field shall 
be left Blank or Null. 

2 4, 5, 
13 

51 X AccDocNumber Accompanying Document Number. 
Accompanying Document numbers shall reflect 
what is in the drawing title block and shall not 
include letters that would be on preprinted 
forms. 
If record describes an Accompanying Document, this 
field shall contain the Accompanying Document’s 
Document Number 
If record describes a Base Document, this field shall 
be left Blank or Null. 

32 5, 13, 
16 

52 X AccDocCage Accompanying Document CAGE Code. 
If record describes an Accompanying Document, this 
field shall contain the Accompanying Document’s 
CAGE Code. 
If record describes a Base Document, this field shall 
be left Blank or Null. 

5 5, 13 

53 X AccDocRevision Accompanying Document Revision. 
If record describes an Accompanying Document, this 
field shall contain the Accompanying Document’s 
Revision. 
The following Accompanying Document Revisions 
are invalid: I, O, Q, S, X, and Z. 
If record describes a Base Document, this field shall 
be left Blank or Null. 

2 4, 5, 
13 

54  [Blank] [Blank] 
Leave Blank or null. 

0 14 

55  [Blank] [Blank] 
Leave Blank or null. 

0 14 

56 X WeaponsSystemCode Weapon System Code. 
Two character designator for the Weapons System. 
Contact the CIO/G-6 Service Desk 256-955-0196, 
usarmy.redstone.amcom.mbx-g6-edms-tag@mail.mil for the 
appropriate data to populate this field. 

15  

57 X Version Version. 
Value shall be: 1.0 

4  

58 X Record End Record End. 
Value shall be: CR/LF (Hex 0D0A). 

2  
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Metadata Notes: 
 
(1) The metadata file is a character delimited, American Standard Code for 
Information Interchange (ASCII) character format encoded text file, with one 
Image Row Entry (Record) per image referencing an image file in a hierarchical 
directory structure. The file and hierarchical directory structure naming 
conventions are not pre-defined. Each Image Row Entry contains a sequenced 
series of pre-defined standard Fields separated by the ASCII Vertical Bar (pipe 
bar) character "|" (decimal 124). Image Row Entries are separated by a Field 58 
(CR/LF) (decimal 13/10). An ASCII Vertical Bar character is required between 
Fields 57 and 58.  There should be no blank lines, or lines that do not conform to 
an Image Row Entry description as defined in the Metadata Description table. 
The file shall contain only those characters permitted by ANSI X3.4-1986.  The 
Vertical Bar character is an invalid character in all Fields. 

 
(2) The metadata file format does not pre-define the size (width) of the Fields. 
Field sizes defined indicate the maximum size allowed.  Padding of Fields is not 
required (i.e. Sheet 1 can be entered as "|1|" and does not require an entry of 
"|0001|". All entries in Fields should be uppercase.  Leading and trailing spaces 
within the Field are ignored (i.e. "|  1  |" will be interpreted the same as "|1|".  Null 
entries may be represented by "||". 

 
(3) Metadata file usage only. These Fields are informational within the metadata 
file to describe Field 13, FileType and are not used as part of the input. 

 
(4) Mandatory data element where "blank" is a valid entry. Null is not a valid entry 
(i.e. "| |" is valid, "||" is invalid). "Blank" is not a valid entry for other mandatory 
fields. 

 
(5) Mandatory field when Image Row Entry is an Accompanying Document. 

 
(6) Field 5, BaseDocRevision for multiple sheet documents will be the same as 
the Field 10, BaseDocSheet Revision for Sheet 1 of the document. 

 
(7) Enter the date of the original drawing when drawing is the original release (i.e. 
Field 10, BaseDocSheet Revision is blank). 

 
(8) Fields 20, FileName; 21 FileExtension; and 23, MediaVolumeID entries must 
contain only ISO-9660 d-characters.  Field 22, FilePath must contain only the d- 
characters and either the backslash "\" or forward slash "/".  The d-characters 
consist of the letters A through Z (upper case), the numbers 0 through 9, and the 
underscore symbol "_".  Corresponding file names of the image files on the 
media must contain only d-characters. Individual subdirectory names within the 
File Path may contain no more than eight (8) characters and consist only of d- 
characters.  The backslash "\" (recommended) or forward slash "/" characters are 
to be used as the separators between individual subdirectory names (do not use 



 

both).  A trailing slash should not be used at the end of the directory structure 
(e.g. "\images\01" or "images\01").  If a relative path is used (i.e. "images\01"), 
the current directory is taken from the perspective of the location of the 
metadatafile.  Example, if there is a directory structure "\images\level1\level2", 
and the path within Field 22, FilePath is "level1\level2", the metadata file must be 
physically located in the subdirectory "\images\level1".  If a relative path is used 
and the images are in the same directory as the metadata file, then use a period 
"." as the path. Drive letter designator and colon are not to be used as part of 
Field 22, FilePath. 

 
(9) If media is an ISO-9660 Compact Disk/DVD, Field 22, FilePath should not 
exceed 66 characters (including directory names, and slashes) and should 
include no more than eight (8) levels in a directory hierarchy.  If the metadata set 
is transferred electronically (i.e. over a network) Field 22, FilePath should only 
use relative path entries. 

 
(10) Field 13, FileType is a five character File Type code which indicates the file 
format of the image file (e.g. CALS Type I raster, AutoCAD 13 Vector, etc.). 
Fields 14 through 19 are descriptors of Field 13. 

 
(11) Field 10, BaseDocSheetRevision for an Individual Sheet of a Base 
Document is the only revision stored in the repository. For this reason Field 5, 
BaseDocRevision is ignored for Base Documents when the metadata file is used 
to populate the repository database. 

 
(12) Dates will be expressed in the following formats: DD-MON-YYYY or DD- 
MON-YYYY:HH24:MI:SS where DD is the Day, MON is the Month, YY or YYYY 
is the Year, HH24 is the 24 hour representation of the Hour (i.e. 15 for 3:00PM), 
MI is the Minutes, and SS is the Seconds.  Examples include "27-JUN- 
1996:15:50:59", "28-JAN-1992:00:00:00" and "28-JAN-1992". 

(13) ACCOMPANYING DOCUMENT NOTES: 

A1. Fields 1, BaseDocNumber; 2, BaseDocCage; 3, BaseDocType; 5, 
BaseDocRevision and 10, BaseDocSheetRevision pertain to the Base Document 
when an Image Row Entry describes an Accompanying Document. Only the 
aforementioned fields should contain entries pertaining to the Base Document for 
an Image Row Entry describing an Accompanying Document.  All fields other 
than the aforementioned pertain to the Accompanying Document when the 
Image Row Entry represents an Accompanying Document. 

 
A2. An Accompanying Document is associated with a Revision of Sheet 1 of the 
Base Document. The Base Document Revision will be resolved from the entry in 
Field 5, BaseDocRevision.  Field 10, BaseDocSheetRevision is ignored.  For 
consistency purposes, Fields 5 and 10 should contain the same value. 



 

A3. If Field 51, AccDocNumber is non-null and contains entries other than 
blanks, then the Image Row Entry is assumed to be describing an Accompanying 
Document. 

 
(14) Fields 54 and 55 are not defined in current implementation of the index but 

are retained as placeholders for future use. 
 

(15) Field 47, SubSheet is not a valid entry for an Accompanying Document and 
should be reflected as a Null entry ("||"). 
 
(16)  For Fields 1. BaseDocNumber and 51, AccDocNumber, the following ASCII 
characters are invalid: 
ASCII Character Description Character (in Quotes) Decimal Value 
Quotation Mark              ( “ )    34 
Dollar Sign               ( $ )    36 
Percent Sign    ( % )    37 
Apostrophe     ( ‘ )    39 
Backslash     ( \ )    92 
Underline     ( _ )    95 
 
(17) For Field 7, DocumentTitle, the following ASCII are invalid: 
ASCII Character Description Character (in Quotes) Decimal Value 
Quotation Mark              ( “ )    34 
Dollar Sign               ( $ )    36 
Percent Sign    ( % )    37 
Apostrophe     ( ‘ )    39 
Backslash     ( \ )    92 
Underline     ( _ )    95 

 
 

(18) Field 8, SheetNumber is listed as a twelve (12) character field.  This is due to 
some organization’s use of what is referred to as "complex sheet numbers".  If 
"complex sheet numbers" are not being used, then this is a four (4) character field. 

 
(19) Fields 44, ParentCage and 45, ParentDocNumber are no longer used and 
should be reflected as a Null entry ("||").


